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NOTICE 
 
1. Kanomax Jpan Co., Ltd. reserves all rights of this software. 
2. No part of this software or manual may be used or reproduced in any form without permission. 
3. The user should purchase a set of software for each computer. 
4. Kanomax Japan Co., Ltd. will not bear any responsibility for the results of using this software or manual. 
5. The specifications of this software or the descriptions of the manual are subject to change without notice. 
6. This software may sometimes malfunction if it is installed in some types of PCs (such as IBM ThinkPad notebook 
PCs). 
7. Install this software, reset the computer, and start the program at that time. 
8. This software is not suitable to long-term monitoring.  Note that collected data will be lost if a power failure 
occurs or the PC system goes down during remote measurement. 
 
 
DESCRIPTIONS IN THIS MANUAL 
 
This manual uses the following descriptions. 
 

Descriptions Meanings 
XX.XX Indicates a numeric value such as 21.56.  Each "X" represents a 

numeral (0 to 9). 
Key entry: Integer between 1 and 800   Indicates inputting an integer between 1 and 800 from the keyboard. 
Key entry: 0.001 to 9.999, integer 
multiple of 0.001   

Indicates inputting an integer multiple of 0.001 in the range from 
0.001 to 9.999 from the keyboard. 

Selection: 1, 6, 10 and 20   Indicates selecting one of the following: 1, 6, 10 and 20. 
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1. INTRODUCTION 
 
1.1 System Configuration 
 
This application software for Windows is applicable to the Handheld LPC made by Kanomax Japan Co., Ltd.  It is 
designed to collect particle, air velocity, temperature and humidity data. 
 
 
       
  
 
 
 
 
 
                      RS232c 

Personal computer Handy LPC 

 
         Fig. 1  System Configuration 
 
 
1.2 Operation Environments 
 
This software runs in the following environments. 
  - Computer: Personal computer with a Pentium CPU or better and one or more COM ports. 
 - Operating system: Japanese or English-version Windows 95 or 98 
 - Memory size: 16MB or more 
 - Hard disk size: At least 5MB for software installation 
 - Display   Display of 640 x 480 or higher resolution compatible with Windows 95 or 98   
                (Recommended resolution: 800 x 600 or higher) 
 - Handheld LPC made by Kanomax Japan Co., Ltd. 
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1.3 Program Block Diagram 
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2. FUNCTIONAL SPECIFICATIONS 
 

Items Descriptions 
Particle Air velocity Temperature Humidity Measurement range 

0 to 6.00E + 6 
particles/cf 

0 to 2.12E + 8 
particles/m* 

0 to 4.00E + 9 CNT 

0 to 1.00 m/s 
0 to 197FPM 

0 to 50.0 ℃ 
32 to 122 F 

3 to 98% 
 

Communication ports: COM1, COM2, COM3 & COM4 selectable Communication type: 
RS-232C Baud rate: 9600, data length: 8 bits, parity: none, stop bit: 1 

Connectable LPC's One unit 
Multi-lingual 
function 

- Japanese and English   
 - Languages are selectable on the menu. 
 - Storing the language selection parameter in the registry. 

Dump Dump setting is done on the LPC. 
- PC side: Selects or cancels the program dump mode (through operation). 
- Dump mode: State ready to receive data sent by the LPC 

Display - Displays dumped data in the text box as is. 
- Displays dumped data on the table. 
- Re-displays data from a data file. 

Saving Dumps data, and then saves it in a specified file.  (You may leave data unsaved.   
- In such a case, a confirmation message appears before proceeding to the next process.) 
- All dumped LPC data and parameters are saved in a file. 
- Data saving format: .TXT and .CSV formats are selectable.   
  (You may process data using Excel.) 

Dump 
 

Printout - Prints all dumped data from the data re-display table window. 
Reading 
meas. 
information 

- Sensor connection: Whether or not temperature and humidity sensors are 
connected or an air velocity sensor is connected 

- Unit: In units of particles, temperature and air velocity 
- Measurement, display and saving processes are controlled automatically in 

accordance with the above setting. 
Setting 
meas. 
parameters 

- LPC address: Fixed to 0. 
- Number of samplings (N): 1 to 3000 times 
- Time interval (Ti): 1 to 1440 minutes  (May be set to a maximum of 24 hours,  
 1440 minutes, in units of minutes.) 
- Sampling time (Ts): 1 to 3600 seconds  (Must not exceed the time interval.   
 An error message shall be displayed if Ts exceeds Ti.) 

Remo
te 
measu
re-me
nt 

Measurement Controls ON/OFF of the pump and reads data. 
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Display - Real-time data display and re-display of data from a remote measurement data 
  file 
- Time series graph 

- Displays air velocity, temperature and humidity graphs in a frame. 
     - Displays a maximum of five types of particle data in a frame when 0.3, 0.5, 1,  
      3 and 5 μm are selected. 
     - Displays "air velocity, temperature and humidity" and "particle" graphs in 
       different graph windows. 

- Graph style: Broken line graph 
- Linear or logarithmic vertical axis is selectable for the particle graphs. 

     -Only linear vertical axis is available for the air velocity, temperature and 
      humidity graphs. 
     - Horizontal axis time width may be set in the ranges from 10 to 60 minutes,  
      from 1 to 24 hours, or from 1 to 30 days. 

- Selectable vertical axis display range 
     - Possible to scroll the graph and change the page using the scroll bars  
      when re-displaying a graph. 
- Displays a time series data table. 
- Displays measurement parameters from the status bar. 

Saving - Saves data and parameters in a specified file after completion of measurement. 
 (You may leave data not to be saved.  In such a case, a confirmatory message  
  appears before proceeding to the next process.) 
- Data saving format: .TXT and .CSV formats are selectable.  
    (You may process data using Excel.) 

Printout - Outputs a graph displayed in an active window to the printer. 
- Outputs all time series data lists to the printer. 
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The buttons are displayed in 
Japanese in the message box 
when the software runs on 

Japanese-version OS. 

3. SETUP AND DELETION OF SOFTWARE 
 
Software distribution files are provided to allow you to set up or delete the LPC software easily. 
 
3.1 Setup 
 
When you execute "Setup.exe," the setup program checks the environments of the PC where the software is to be 
installed and installs the necessary files automatically.  The software is installed in the "C:¥Program File¥LPC" 
directory.  You may change the directory by clicking the "Change Directory" button before starting installation. 
 
(1) When you begin to install the software, the English screen appears first. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
    Fig. 2  Installation Opening Screen 
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(2) When all necessary files have been installed, the following menu appears.  You may select setup in Japanese or 
English. 

                    Fig. 3 Language Selection Menu 
 
(3) When you select Japanese, the Japanese setup screen appears.  When you select English, the English setup 

screen appears.  You may execute setup on either screen.  The selected language is registered in the registry.  
When the installed application (LPC.EXE) is executed, display is given in the selected language on the application 
screen. 

 
 
3.2 Deletion 
 
You may delete the Handy LPC software using "Add/Delete Application" on the control panel.  The deletion screen 
is displayed in English. 
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4. PROGRAM STARTUP AND OPERATION PROCEDURES 
 
   ①Starting the program Startup operation 

(Execution file: LPC.EXE)  
 
 

  ②Initial screen 
     A file having been opened

before quitting the program
previously is displayed. 
    

 
   ③RS-232C Settings 
  Select a serial communication port. 
  (Selectable ports: COM1 to COM4) 
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  Remote measurement and dump 
 Select on the menu or click on the icon on the tool bar

to execute measurement or dump. 

   ④ Remote measurement 
 
 
 
 
 

  ⑤ Data saving 
  In dumping data, click on the Save button

in the Dump dialog box. 
  In measurement, select "Save" on the

"File" menu to save data as shown on the
right. 

                          Fig. 4 Operation Procedures 
 

  ⑥ Quitting program 
    Select "Exit" on the "File" menu to quit 

the program. 
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5. SCREEN CONFIGURATION 
 
Arrange the menus and tool bar in the parent window.  The menus and tool bar in the parent window change 
according to the active child window. 
 
 

Program name Data file name  Title bar Menu bar 

Tool bar 

Time series graph 
child window 

Data table child 
window 

Status bar

 
RS-232C 
communication 
port 

 Number of 
samplings 

Time interval Sampling time Program status Data status 
 
 
Fig. 5 Basic Screen Configuration 
 
(１)Tool bar 
The frequently used menu options are arranged as buttons on the tool bar.  Clicking a button executes the 
corresponding menu option immediately. 
 
(２)Status bar 
The program status, data status and measurement parameters are  
displayed on the status bar. 
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6. DATA FILE 
 
6.1 File Menu 

 Fig. 6 File Menu 
 
(1) New 
 Select "New," and the program executes the following processing. 

1) If unsaved data exists in the memory, the "Save File Confirmation" dialog box appears.  You may save the 
unsaved data in this dialog box. 
2) The file name is "NEWFILE.KRM."  Data is cleared and the parameters remain unchanged. 

 
(2) Open 
 Select "Open," and the program executes the following processing. 

1) If unsaved data exists in the memory, the "Save File Confirmation" dialog box appears.  You may save the 
unsaved data in this dialog box. 
2) The "Open" dialog box appears.  Open an existing file in this dialog box. 

 
(3) Save 
 Select "Save," and the "Name and Save File" dialog box appears.  You may specify any file name and save data in 

that file. 
 
(4) Print 
 Select "Print" to output a graph or data list in the active child window to the printer. 
 
(5) 1 E:¥Win LPC¥…, 2 E:¥Win LPC¥…, etc. 
  Open a file used recently using the same procedures as described in (2) Open. 
 
(6) Exit 
 Select "Exit," and the program executes the following processing. 

1) If unsaved data exists in the memory, the "Save File Confirmation" dialog box appears.  You may save the 
unsaved data in this dialog box. 
2) The program quits. 
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6.2 Data File List 
 
Measurement data 
file 

- File name: ###.KRM 
- File type: Binary 
- Contents: File information, measurement parameters and remote measurement data 
* This file format is exclusive for the internal processing of this program and is not 

disclosed.  This program accesses the data file and re-displays remote measurement 
data. 

Dump data file - File name: ###.KDU 
- File type: Binary 
- Contents: File information, measurement parameters and dumped data 
* This file format is exclusive for the internal processing of this program and is not 
disclosed.  This program accesses the dump data file and re-displays dumped data. 

Data file 
* In the CSV 
format compatible 
with Excel or the 
text format 

- File name: ###.CSV or ###.TXT 
- File type: Microsoft Excel character file with comma delimiters 
- Contents  Remote measurement: Measurement parameters & measured data 
     Dump: Dumped data 
*A .CSV or .TXT file is created according to your selection together with a measurement
data file (or dump data file). 
* For details, see Appendices 1 and 2. 

Registration in 
registry 

The following are saved in "HKEY_CURRENT USER¥Software¥VB and VBA 
Program Settings¥Handy LPC Measuring Software" in the registry: 
  Default remote measurement parameters, RS-232C communication port, 

language selection parameter, recently used data file list, and size and position 
of the parent window 
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7. SETTINGS 
 
7.1 Setting RS-232C Communication Port 

 Fig. 7 RS-232C Settings Dialog Box 
 
Select an RS-232C communication port from among COM1, COM2, COM3 and COM4 from the combo box.  Other 
RS-232C port parameters are fixed as shown below. 
   RS-232C address of Handy LPC: 0 
   Baud rate: 9600, data length: 8 bits, parity: none, stop bit: 1 
 
7.2 Setting Measurement Parameters 

 Fig. 8 Measurement Parameter Settings Dialog Box 
 
  Set the remote measurement parameters as shown below in the measurement parameter settings dialog box 
shown in Fig. 8. 

Items Set values 
Sampling time Set the sampling time in units of seconds. 

Key entry: Integer between 1 and 3600 
Selection: 1, 5, 10, 30, 60, 300, 600 and 1200 

Time interval Set the time interval in units of minutes. 
Key entry: Integer between 1 and 1440 
Selection: 1, 5, 10, 20, 30, 60, 120 and 180 

Number of 
samplings 

Key entry: Integer between 1 and 30000 
Selection: 1, 10, 60, 120, 300, 600, 1200 and 3000 

 
 
 

 14



8. REMOTE MEASUREMENT 
 
 Carry out remote measurement in the Handy LPC remote mode as shown below. 
 
8.1 Starting and Stopping Measurement 
 
(1) Starting measurement 
 
Execute "Measurement" on the "Measurement" menu, and the "Measurement Parameter Settings Dialog Box 2" 
appears. 
The "Measurement Parameter Settings Dialog Box 2" has quite the same details including the parameter buffer as 
the "Measurement Parameter Settings Dialog Box" (shown in Fig. 8), with the only exception of the following: 
The  Measure (Start Measurement) button is provided, instead of the OK  button. 
 
 Click the Measure(Start Measurement) button to start measurement. 
 
(2) Stopping measurement 
 
Execute "Measurement Stop" on the "Measurement" menu during measurement, and a dialog box for confirming 
stoppage of measurement appears.  Use this dialog box to stop measurement.  If measurement is stopped halfway, 
data collected before stopping measurement may be saved.  The number of read data is the number of data read 
actually. 
 
 
8.2 Measurement 
 
(1) Measurement control 
During measurement, the program controls the measurement timing and ON/OFF of the Handy LPC pump as well 
as reads measured data. 
 
(2) Data display 
During measurement, the program provides real-time display of a time series graph of data and numeric values.  
For details, see Fig. 5 "Basic Screen Configuration" and section 10 "DISPLAYING REMOTE MEASUREMENT 
DATA." 
 
8.3 Storing Measured Data 
 

After completion of measurement, select "Save" on the "File" menu to save measured data in any selected file.  You 
may select either file format: .TXT (text file), or .CSV (Microsoft Excel character file with comma delimiters). 
For example, when you specify a data file name "Test" and select the ".TXT" format, data is saved in the Test.KRM 
and Test.TXT files.  When you select the ".CSV" format, data is saved in the Test.KRM and Test.CSV files. 
 
* For details of the data file formats, see Appendix 1 "Sample of Remote Measurement Data File. 
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9. DUMP 
Use the Handy LPC Dump mode to dump data. 
 
 Execute "Dump" on the "Dump" menu.  The program enters the dump mode and the "Dump Dialog Box" (shown 
in Fig. 9) appears. 
In the dump mode, the PC is ready to receive data sent by the Handy LPC.  Carry out the dump-related settings on 
the LPC and press the START button.  The Handy LPC dumps specified data to the PC. 
 

Data status display area 

Raw data display area 

Data table 

     Fig.9 Dump Dialog Box 
 
(1) Displaying read data 
 
Read raw data is displayed in the "Raw Data Display Area" on the left of the "Dump Dialog Box" and the data 
storage status is displayed in the "Data Status Display Area" in the lower part.  Clicking the 
変換 >>  (Convert) or Save button converts unprocessed data.  Processed data is displayed in the data table.  
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(2) Saving data 
 
When you click the Save button, the "Name and Save File" dialog box appears and you may save data in a file with 
an optional file name.  You may select either file format: .TXT (text file), or .CSV (Microsoft Excel character file with 
comma delimiters).For example, when you specify a data file name "Test" and select the ".TXT" format, data is saved 
in the Test.KDU and Test.TXT files.  When you select the ".CSV" format, data is saved in the Test.KDU and 
Test.CSV files. 
 
* For details of the data file formats, see Appendix 2 "Sample of Dump Data File." 
 
(3) Clearing data 
Clicking the  Clear button clears dumped data. 
  
Unless you clear previously dumped data before dumping the next data, newly dumped data is added to the 
previous data. 
 
(4) Exiting the dump mode 
When you click the Close button, the program executes the following processing: 
1) The program displays the "Save File Confirmation" dialog box if dumped data hasn't been saved.  You may save 
the dumped data. 
2) The program closes the "Dump" dialog box and exits the dump mode. 
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10. DISPLAYING REMOTE MEASUREMENT DATA 
 
10.1 Data Display Format 
 

 Unit Display format Example 
Particle CNT、/cf、/m3 ＜１００００ ： ＸＸＸＸ 

≧１００００ ： Ｘ．ＸＸＸＥ＋Ｘ 
２５６８ 

１．２５６Ｅ＋５ 
Temperature deg C、deg F ＸＸＸ．Ｘ ２６．５ 

Humidity % ＸＸＸ．Ｘ ７５．３ 
m/s Ｘ．ＸＸＸ ０．６５２ Air velocity 

FPM ＸＸＸ．Ｘ １２５．３ 
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10.2 Particle Time Series Graph 
 
(1) Time series graph display window 
 Two types of particle time series graphs are available as shown in Figs. 10 and 11.  One graph has a linear 
vertical axis, and the other has a logarithmic vertical axis. 
 

     Fig. 10 Particle Time Series Graph (Linear) Display Window 
 

cursor 

Graph display 
frame 

Particle 
data unit 

Particle 
data types 

are 
color-coded

5μm data 3 μm data 1 μm data 0.5 μm data  0.3μm data Sampling start time 

Status bar: 
 Data at the 

cursor positions 
are displayed. 

Page scroll bar 

Time axis 

 
  Fig. 11 Particle Time Series Graph (Logarithmic) Display Window 
You may scroll the graph, move the cursors and display data at the cursor positions in the window shown above.  
The graph cursors disappear and the scroll bar is not functional during measurement. 
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(2) Setting the time series graph display parameters 
 
    Set the time series graph display parameters in the following dialog box. 
 

      Fig. 12 Particle Time Series Graph Display Parameter Settings Dialog Box Set items 
 
 Set items： 

Set items Settings 
Horizontal (time) axis 
range 

The following ranges are selectable: 
 10, 20, 30, 40, 50 and 60 minutes 
 1 to 24 hours in units of hours 
 1 to 30 days in units of days 

Vertical axis display item A maximum of five types of particle data may be displayed in a frame when 
0.3, 0.5, 1, 3 and 5 μm are selected. 

Vertical axis type Linear or logarithmic axis is selectable. 
Vertical axis range The following ranges are selectable: 

Linear: 10, 20, 50, 100, 200, 500, 1000, 2000, 5000, 1.00E + 0.4, 1.00E + 0.4, 
1.00E + 05, 1.00E + 06, 1.00E + 07, 1.00E + 08, & 1.00E + 09 
Logarithmic: 10, 100, 1000, 1.00E + 04, 1.00E + 04, 1.00E + 05, 1.00E + 06, 
1.00E + 07, 1.00E + 08, & 1.00E + 09 
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10.3 Temperature, Humidity and Air Velocity Time Series Graph 
 
(1) Time series graph display window 
 The vertical axis of the temperature, humidity and air velocity time series graph is fixed to the linear axis. 
 

Cursor-position air velocity 
data 

Cursor-position  
humidity data 

Cursor-position 
temperature data 

 
 
    Fig. 13 Temperature, Humidity and Air Velocity Time Series Graph Display Window 
 
 You may scroll the graph, move the cursor and display data at the cursor position in the window shown above. 
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(2) Setting the time series graph display parameters 
 
    Set the time series graph display parameters in the following dialog box. 
 

     Fig. 14 Temperature, Humidity and Air Velocity Time Series Graph Display Parameter Settings Dialog Box 
 
Set items： 

Set items Settings 
Horizontal (time) axis range The following ranges are selectable: 

 10, 20, 30, 40, 50 and 60 minutes 
  1 to 24 hours in units of hours 
 1 to 30 days in units of days 

Max. Selection： 5、10、15、20、25、30、35、40、45、50 Temperature  
(deg. C ) Min. Selection： 0、 5、10、15、20、25、30、35、40、45 

Max. Selection：40、50、60、70、80、90、100、110、120、130 Temperature
（deg F） Min. Selection：30、40、50、60、70、80、 90、100、110、120 

Max. Selection：10、20、30、40、50、60、70、80、90、100 Humidity  
(%) Min. Selection： 0、10、20、30、40、50、60、70、80、 90 

Max. Selection：0.1、0.2、0.3、0.4、0.5、0.6、0.7、0.8、0.9、1.0Air velocity 
(m/s) Min. Selection：0.0、0.1、0.2、0.3、0.4、0.5、0.6、0.7、0.8、0.9

Max. Selection：20、40、60、80、100、120、140、160、180、200 

Vertical axis 
display range 

Air velocity 
(FPM) Min. Selection： 0、20、40、60、80、100、120、140、160、180 
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10.4 Data Table 
 
Time series data values are displayed in the data table display window.  The window size is adjustable. 
 

      Fig. 15 Data Table Display Window 
 
 
 

      Fig. 16 Data Table Display Window  (Scrolled to Right of Table) 
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11. DISPLAYING DUMP DATA 
 
The dump data display format is the same as the dump data format of the Handy LPC. 
Dump data is displayed on a table only.  The dump data table display window is as shown below.  The vertical size 
of the window is adjustable.  The horizontal size is fixed. 
 

Symbol comment indicating 

the Handy LPC status 

      Fig. 17 Dump Data Table Display Window 
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12. OTHER FUNCTIONS 
 
12.1 Converting Japanese-Version and English-Version Software 
 
 You may select the Japanese-version or English-version software on the "Option" menu. 
 

     Fig. 18 Converting Japanese-Version and English-Version Software 
 
 
12.2 Aligning Windows 
 
Execute "Align Windows" on the "Window" menu to arrange the time series graph window and data table window as 
displayed on the Basic screen (shown in Fig. 5). 
If a check mark is put on "Standard Layout," the child windows are automatically re-arranged when the parent 
windows are re-sized. 

 
     Fig. 19 Windows Alignment 
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12.3 Displaying Version Information 
 
Executing "Version Information" on the "Help" menu displays the software version information display dialog box 
(shown in Fig. 20). 
 

       Fig. 20 Software Version Information Display Dialog Box 
 
 
12.4 Printing Function 
 
 This program is capable of outputting time series graphs and time series data lists to the printer. 
 
 See Appendix 3 "Printout Samples of Time Series Graph and Time Series Data List." 
 
(1) Printing time series graphs 
 
Display a graph to be printed in the time series graph window.  Execute "Print" on the "File" menu when the time 
series graph window is active, and the graph is output to the printer. 
 
(2) Printing time series data lists 
 
Activate the data table and execute "Print" on the "File" menu.  All data are output to the printer. 
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Appendix 1: Sample of Remote Measurement Data File 
 
[Remote Measurement Data] 

Sampling Time 1  

Interval Time 22  

The Number of Sample 8  

Date & Time  LPC Status  0.3um(CNT)  0.5um(CNT)  1um(CNT)  3um(CNT)  5um(CNT)  T(deg C)  H(%)  V(m/s) 

2000/6/24 9:01  OK 3876 3113 1966 844 46 15.5 66.5 0.82

2000/6/24 9:23  OK 4875 3680 2954 1544 58 29.6 54.8 0.53

2000/6/24 9:45  OK 4275 3200 2685 1509 10 12 52 0.8

2000/6/24 10:07  OK 3050 2250 1368 573 28 28.9 69.5 0.4

2000/6/24 10:29  OK 3405 2495 1349 687 27 18.2 64.2 0.33

2000/6/24 10:51  OK 3119 2539 1456 770 63 19.1 68.1 0.26

2000/6/24 11:13  OK 4295 3164 1745 956 78 22.5 58.5 0.1

2000/6/24 11:35  OK 4519 3997 2663 1250 56 20.8 68.3 0.43

 
Appendix 2: Sample of Dump Data File 
 
[Dump Data] 

1  Repeat   2000/5/16  16:17:41    00:00:01  CNT    deg C  m/s  F  7 0 0 0 0       *****       *****       ***** 

2  Repeat   2000/5/16  16:17:47    00:00:01  CNT    deg C  m/s  F  8 0 0 0 0       *****       *****       ***** 

3  Repeat   2000/5/16  16:17:52    00:00:01  CNT    deg C  m/s  F  10 0 0 0 0       *****       *****       ***** 

4  Repeat   2000/5/16  16:17:57    00:00:01  CNT    deg C  m/s  F  6 0 0 0 0       *****       *****       ***** 

5  Repeat   2000/5/16  16:18:02    00:00:01  CNT    deg C  m/s  F  12 0 0 0 0       *****       *****       ***** 

6  Repeat   2000/5/16  16:21:56    00:00:01  CNT    deg C  m/s  F  9 0 0 0 0       *****       *****       ***** 

7  Repeat   2000/5/16  16:22:02    00:00:01  CNT    deg C  m/s  F  5 0 0 0 0       *****       *****       ***** 

8  Repeat   2000/5/16  16:22:07    00:00:01  CNT    deg C  m/s  F  7 0 0 0 0       *****       *****       ***** 

9  Repeat   2000/5/16  16:22:12    00:00:01  CNT    deg C  m/s  F  4 0 0 0 0       *****       *****       ***** 

10  Repeat   2000/5/16  16:22:17    00:00:01  CNT    deg C  m/s  F  8 0 0 0 0       *****       *****       ***** 
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Appendix 3: Printout Samples of Time Series Graph and Time Series Data List 
 
  The printout samples are shown on the following pages. 
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